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CHAPTER

ONE

INTRODUCTION

Model Viewer for Modflow 6 is a version of Model Viewer that has been customized to display the results of Modflow
6.

For brevity, “Model Viewer for Modflow 6” is shortened to “MvMf6” in the Help pages.

Users who wish to display results of other models (e.g., MODFLOW-2000, MT3DMS, SUTRA, etc.) should use the
standard version of Model Viewer.

1.1 Getting Started

1. To use MvMf6 (Model Viewer for Modflow 6), you must first run a Modflow 6 model to generate simulation
results.

2. Create a new mvmf6 file.

3. Load Modflow 6 data (simulation results).

4. Learn to zoom, rotate, and pan.

5. View scalar data (heads) as a solid or a set of isosurfaces.

6. View vector data (flows), if available.

7. View cells that contain model features such as streams and wells.

8. View auxiliary graphic objects such as grid lines and bounding box.

9. Learn how to use the toolboxes for data exploration and for controlling various aspects of the display.

10. Save the mvmf6 file.

1.2 User Interface

• Model results are shown in the Display Area.

1
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• Model Viewer provides five menus (File, Show, Action, Toolbox, Help).

– Each menu provides a drop-down list of commands.

– Grayed out commands are inactive.

– Certain commands can be alternatively invoked from the keyboard by holding down the Ctrl key and then
pressing a letter. This keyboard equivalent, when available, is indicated to the right of the command.

• The type of model and type of scalar data are indicated at the lower right corner of the program window.

2 Chapter 1. Introduction
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1.3 The mvmf6 File

• The mvmf6 file is used by Model Viewer for Modflow 6 to keep track of the model data and display settings
for a particular set of simulation results (model run). This file has a name that ends with .mvmf6.

• The New, Open, Close, Save and Save As commands (under the File menu) operate on mvmf6 files.

• The New command begins the process of creating a new mvmf6 file. You will be asked to load model data.

• When you save an mvmf6 file, Model Viewer for Modflow 6 writes the following information to disk: the
name(s) of model data files and all current display settings.

Note:

• The mvmf6 file does not contain the actual model data.

• The mvmf6 file must be save to the folder containing the “name” file.

• When you open an mvmf6 file, Model Viewer for Modflow 6 loads the model data and sets the display according
to the information saved in the mvmf6 file.

• When you close an mvmf6 file, Model Viewer for Modflow 6 terminates the display of data. The program
window becomes blank. The Close command is useful during repeated cycles of running a model and viewing
the results. While model results are displayed in Model Viewer, the model data files cannot be over-written by
another program. Closing the mvmf6 file releases the model data files so that the model can run to generate a
new set of results.

• Every time you change a display setting (for example, the color bar limits), the current mvmf6 file is considered
to have been changed. If you did not saved the mvmf6 file after the changes, and you try to (a) create a new
mvmf6 file, or (b) close the current mvmf6 file, or (c) exit Model Viewer for Modflow 6, you will be prompted
to save the mvmf6 file before continuing.

1.4 Loading Modflow 6 Data

Model Viewer for MODFLOW 6 requires the OC6 file be defined that sets the HEAD FILEOUT option to view
simulated heads and optionally the BUDGET FILEOUT to view vectors and model features. After a Modflow 6 run
has been successfully executed, the model data (simulation results) may be loaded to Model Viewer for Modflow 6
for visualization.

1. Click “File” and select “New.” The “Modflow 6 Data Files” dialog is displayed.

2. Specify either the Name File for a Groundwater Flow Model, or the “Grid”, “Head”, and “Budget” files generated
by the model.

3. Click “OK”

1.3. The mvmf6 File 3
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CHAPTER

TWO

ZOOMING, ROTATION, AND PANNING

MvMf6 displays an object as viewed from a particular viewpoint. Zooming, rotation, and panning are different ways
to interact with the object by changing the viewpoint.

• Zooming in moves the viewpoint closer to the object being viewed, causing the object to appear bigger.

• Zooming out moves the viewpoint away from the object being viewed, causing the object to appear smaller.

• Rotation moves the viewpoint in an angular direction so that the viewed object appears to rotate.

• Panning moves the viewpoint laterally so that the viewed object appears to move sideways.

Zooming, rotation, and panning are performed by mouse buttons. Two types of mouse interactions are provided:

• trackball-mode interaction

• joystick-mode interaction

Trackball-mode interaction is the default. However, the user may change the interaction mode from one to the other.

2.1 Trackball-Mode Interaction

First, put the cursor inside the display area. Then:

• To zoom in, press and hold the right mouse button, and drag the cursor upward.

• To zoom out, press and hold the right mouse button, and drag the cursor downward.

• To rotate, press and hold the left mouse button, and drag the cursor in the direction of rotation.

• To rotate around an axis perpendicular to the screen, hold down the Ctrl key, press and hold the left mouse
button, and drag the cursor in the direction of rotation.

• To pan, hold down the Shift key, press and hold the left mouse button, and drag the cursor in the direction of
panning.

2.2 Joystick-Mode Interaction

In joystick-mode interaction, the speed and direction of zooming, rotation, and panning are determined by the position
of the cursor relative to the center of the display area.

• When the cursor is far from the center, interaction is faster.

• When the cursor is near the center of the display area, interaction is slower.

• To zoom in, place the cursor on the upper half of the display area, then press and hold the right mouse button.
To end zooming, release the button.
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• To zoom out, place the cursor on the lower half of the display area, then press and hold the right mouse button.
To end zooming, release the button.

• To rotate, place the cursor such that its position relative to the display area center indicates the direction of
rotation, then press and hold the left mouse button. To end rotation, release the button.

• To rotate around an axis perpendicular to the screen, place the cursor such that its position relative to the
display area center indicates the direction of rotation, then press and hold the Ctrl key and left mouse button. To
end rotation, release the button.

• To pan, place the cursor such that its position relative to the display area center indicates the direction of panning,
hold down the Shift key, then press and hold the left mouse button. To end panning, release the button.

2.3 Changing Interaction Mode

1. Click the File menu and select Preferences.

2. Select the type of mouse interaction, either Trackball-Mode or Joystick-Mode.

3. Click OK.

6 Chapter 2. Zooming, Rotation, and Panning



CHAPTER

THREE

CELL INDEXING

MvMf6 use the same i-j-k indexing system as used by Modflow 6.

• The i-j-k Index System for Cells

• The i-j-k Index System for Gridlines

3.1 The i-j-k Index System for Cells

• For a Modflow 6 model with structured discretization (DIS grid)

– The index i runs along a row.

– The index j runs along a column.

– The index k increases from one layer to the next, counting from top to bottom.

7
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3.2 The i-j-k Index System for Gridlines

For a model with Structured Discretization (DIS grid) MvMf6 can display 3 gridline sets defined respectively by the
indices i, j, and k. These gridline sets are illustrated below.

8 Chapter 3. Cell Indexing



CHAPTER

FOUR

DATA VISUALIZATION

MvMf6 can display the following:

• Scalar data such as hydraulic head or solute concentration.

• Vector data such as specific discharge or fluid velocity.

• Cells or nodes that represent model features such as rivers and wells.

• Auxiliary graphic objects such as grid lines and bounding box to provide spatial reference and orientation.

• A line drawing (overlay) on top of the grid or above the grid.

4.1 Scalar Data

• MvMf6 displays scalar data (for example, hydraulic head) by mapping scalar values to a color bar.

• Scalar data may be displayed as:

– a solid

– a set of isosurfaces

• The interior details of the scalar data may be explored by:

– cropping

– thresholding

To show scalar data as a solid

• Click the Show menu and select Solid.

To show scalar data as isosurfaces

• Click the Show menu and select Isosurfaces.

To hide the scalar data

• Click the Show menu and select None.

To specify or change the type of scalar data to display

1. If the Data toolbox is not visible, display it by clicking the Toolbox menu and selecting Data.

2. Click the Scalar tab.

3. From the drop-list box, select the type of scalar data to display.

9
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4.2 Color Bar

• MvMf6 uses a red-to-blue color bar to represent a range of scalar values. (How to customize the color bar)

• Either red or blue may represent the upper limit of the scalar range.

• Other colors can be selected as the end members of the color bar.

• The color bar may be linear or logarithmic.

• Values outside the scalar range are clamped to the corresponding endpoint color. (For example, if red represents
the lower limit of 40 and blue represents the upper limit of 60, then all values below 40 are displayed as red, and
all values above 60 are displayed as blue.)

• For a logarithmic color bar, both endpoints of the scalar range must be positive.

• To alternately show or hide the color bar, click the Show menu and select Color Bar.

4.3 Solid

• When scalar data are represented as a solid, all active cells in the grid are colored by mapping scalar values to
the color bar.

• Inactive cells, if present in the grid, are excluded.

• Because the solid is rendered as opaque, only the exterior surface is visible.

• The interior of the solid can be examined by thresholding and cropping.

MvMf6 provides 3 coloring schemes: (How to specify the coloring scheme)

• Blocky: Each cell has a uniform color according to the nodal value for that cell. This scheme is available only
for finite-difference models (such as MODFLOW) but not for finite-element models.

10 Chapter 4. Data Visualization
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• Smooth: Nodal values are interpolated to yield scalar values that vary smoothly from one node to another.
Consequently, the colors vary smoothly through the solid.

• Banded: The solid is divided by isosurfaces into a discrete number of bands. Each band has a uniform color.

4.3. Solid 11
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4.4 Isosurface

• An isosurface is a surface of constant scalar value.

• Each isosurface is colored according to the color bar.

• Isosurfaces may be examined by cropping.

How to create isosurfaces

4.5 Thresholding

• Thresholding is a method to explore a solid by removing those portions where the scalar values lie outside a
threshold range. (How to threshold)

• If the coloring scheme is blocky, thresholding will result in exclusion of all cells whose nodal values lie outside
the threshold range.

• If the coloring scheme is smooth, thresholding will result in “carving” away portions of the solid along smooth,
interpolated surfaces.

12 Chapter 4. Data Visualization
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• Similarly, if the coloring scheme is banded, thresholding will also result in “carving” away portions of the solid
along smooth, interpolated surfaces.

4.6 Cropping

• Cropping is a method for exploring a solid or a set of isosurfaces by showing only that portion that lies on one
side of a cropping plane. (How to crop)

• MvMf6 implements three pairs of cropping planes, denoted as the x, y, and z.

• By default, the pair of x cropping planes is perpendicular to the x axis, and similarly for the y and z cropping
planes.

• However, the x and y cropping planes may also be rotated.

• When cropping is enabled, only the portion between a pair of cropping planes is displayed.

• The locations of the pair of x cropping planes, in their unrotated state, are specified as x = value1 (Min position)
and x = value2 (Max position), where value1 is less than or equal to value2. The locations of the pair of y and z
cropping planes are specified similarily.

Note:

• The x, y, and z axes are normalized to range from 0 to 1.

4.6. Cropping 13
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The figure below illustrates cropping a solid using the pair of y cropping planes at y = 0.3 (Min position) and y = 0.7
(Max position).

The figure below illustrates cropping a set of isosurfaces using the pair of y cropping planes at y = 0.3 (Min position)
and y = 0.7 (Min position).

14 Chapter 4. Data Visualization
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4.7 Vector Data

To show or hide vector data

• Click the Show menu and select Vector. This alternately shows or hides the vectors.

• MvMf6 displays a vector as a line oriented in the direction of the vector. The length of the line is proportional to
the vector magnitude or, if choosen by the user, the logarithm of the ratio of the vector magnitude to the smallest
vector magnitude. (How to control vector display)

• The starting point of the vector is the center of a cell. A small cube (called the base) may be displayed at the
starting point.

Note:

• Showing all vectors in the grid may result in a very cluttered picture.

• For models with structured discretization (DIS grid) , vectors can be displayed for a selected range of i, j, and k
indices of the grid or cropped i the same way as scalar data may be cropped. In addition, the vector data may be
“subsampled” by showing every n-th vector (n > 1) along the i, j, and k directions.

• Thresholding may be applied to display only those vectors having magnitudes within a specified range.

4.8 Model Features

To show or hide model features

• Click the Show menu and select Model Features. This alternately shows or hides the model features.

4.7. Vector Data 15
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• MvMf6 can display cells that represent model features such as streams, wells, or boundary conditions.

• Each type of model feature is indicated by a different color. (How to control model feature display)

4.9 Auxiliary Graphic Objects

MvMf6 can display the following auxiliary graphic objects to provide spatial reference and orientation:

• Grid Shell: A semi-transparent shell representing the outer surface of the volume composed of all active cells.
(How to set the color and opacity of the grid shell)

• Grid Lines: For models with structured discretization (DIS grid), three gridline sets defined respectively by the
index i, j, or, k. (How to control the gridline sets)

• Axes Symbol: Three-mutually perpendicular lines or tubes, colored red, green, and blue, respectively indicating
the orientation of the x, y, and z axes. (How to set the size and position of the axes symbol)

• Bounding Box: The smallest box that contains all active cells. The edges of the bounding box are aligned with
the x-y-z axis system.

To alternately show or hide the above items, click the Show menu and select the item.

4.10 Overlay

• MvMf6 can import a line drawing to be displayed as an “overlay” on the top surface of a grid or above the grid.
(How to import an overlay)

• The line drawing must be contained in either an ESRI Shapefile or a DXF file. However, not all entities in a DXF
file are supported. The following DXF entities are displayed: line, polyline, circle, arc, and text.

• As illustrated below, the overlay may be “draped” on the top surface of the grid (left figure), or displayed as a
flat drawing above the grid (right figure).

16 Chapter 4. Data Visualization
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To show or hide the overlay (after it has been imported)

• Click the Show menu and select Overlay. This alternately shows or hides the overlay.

4.11 Simulation Time

To alternately show or hide the simulation time, click the Show menu and select Time.

• The simulation time is displayed near the lower left corner of the display area

• The time unit is that assumed in the model.

4.11. Simulation Time 17
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CHAPTER

FIVE

TOOLBOXES

MvMf6 provides a number of small dialog boxes, called toolboxes, for controlling specific aspects of the display.

• The Toolbox menu provides commands to show or hide the toolboxes.

• A check mark next to a command indicates that the corresponding toolbox is shown. Selecting this command
will hide the toolbox.

• The absence of a check mark next to a command indicates that the corresponding toolbox is hidden. Selecting
this command will show the toolbox.

• Each toolbox may be closed by clicking Done.

• Toolboxes do not have to be closed for the program to continue.

• Except for text entries, all controls on toolboxes will take effect immediately when changed.

• For text entries, the user must click Apply to apply the change.

5.1 Data Toolbox

The Data toolbox displays the maximum and minimum data values at the current time, and enables you to select the
type of scalar data to display.

• If the Data toolbox is not visible, display it by clicking the Toolbox menu and selecting Data.

• The Scalar tab displays the minimum and maximum scalar values at the current time. You may also select the
type of scalar data to display from the drop-list box.

• The Vector tab displays the minimum and maximum magnitude of vectors at the current time.

• The Pathline tab displays the minimum and maximum travel times for all pathlines.

5.2 Color Bar Toolbox

The Color Bar toolbox controls the properties of the color bar.

• If the Color Bar toolbox is not visible, display it by clicking the Toolbox menu and selecting Color Bar.

• Clicking Default will assign default settings to the selected tab. Default settings are given in parentheses below.

• The Source tab allows you to specify whether the color bar displays data for the active data set or the pathlines.

• The Limits tab allows you to:

– Set the scalar value at the blue and red limits. The default settings are:

19
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∗ blue = minimum scalar value at the current time

∗ red = maximum scalar value at the current time

– Specify a linear color bar by unchecking the logarithmic scale option. (This is the default setting.)

– Specify a logarithmic color bar by checking the logarithmic scale option.

– Interchange the scalar values at the blue and red limits by clicking Reverse.

• The Size tab allows you to:

– Set the width of the color bar in pixels. (20)

– Set the height of the color bar in pixels. (200)

– Set the offset distance in pixels from the right edge of the color bar to the right side of the display area.
(100)

• The Labels tab allows you to:

– Set the font size (in points) of the labels. (14)

– Set the number of labels. (5)

– Set the precision (number of significant places) of the labels. (2)

– Set the label color to black, gray, or white. (black)

• The Colors tab allows you to:

– Select the Default color scheme

– Select the Modified color scheme which is similar to the default except that the thickness of the yellow and
aqua portions of the color bar have been increased at the expense of the green, red, and blue portions of the
color bar.

– Select a Custom color scheme in which the beginning and ending colors are selected by the user.

If the Custom color scheme is selected, the user clicks the Choose First Color or Choose Last Color buttons to choose
the colors of the endpoints of the color bar.

• The Crop tab allows you to:

– Specify the Min and Max positions of the x, y, and z cropping planes. (Min = 0, Max = 1)

– Specify the Delta value, which is used to increase or decrease the Min or Max position when the up or
down arrow is clicked. (0.1)

– Specify the Crop Angle to rotate the x and y cropping planes. The crop angle can be from -45 to 45 degrees.
(0)

5.3 Lighting Toolbox

The Lighting toolbox allows adjustment of how graphic objects are illuminated. The default lighting provided by
MvMf6 is a headlight, which illuminates objects from the direction of the viewpoint. The default setting is adequate
for most cases, and lighting adjustment is often unnecessary.

• If the Lighting toolbox is not visible, display it by clicking the Toolbox menu and selecting Lighting.

• Clicking Default will assign default settings to the selected tab. Default settings are given in parentheses below.

• The Lights tab allows you to:

– Turn on the headlight by checking the Headlight option. (By default, the headlight is turned on.)

20 Chapter 5. Toolboxes
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– Turn off the headlight by unchecking the Headlight option.

– Set the headlight intensity. (1)

– Turn on the auxiliary light by checking the Auxiliary Light option.

– Turn off the auxiliary light by unchecking the Auxiliary Light option. (By default, the auxiliary light is
turned off.)

– Set the auxiliary light intensity. (0)

– Set the vector direction from which the auxiliary light illuminates graphic objects. The vector components
(x, y, z) may vary from -1 to 1. For example, if x= 0, y= 0, z= 1, the auxiliary light will shine from the
positive z axis towards the negativez axis.

• The Surface tab allows you to set the surface properties of graphic objects. These properties are:

– Diffuse: This parameters is currently not adjustable and is set to 1.0.

– Ambient: Increasing this parameter above 0 gives surfaces a “washed out” appearance and reduces the
shading. Setting this parameter to the maximum value of 1 causes surfaces to appear white. (0)

– Specular: The amount of reflected light. (0)

– Specular Power: The surface shininess. (1)

• The Background tab allows you to:

– Set the background color to white by selecting the White option. (White is the default background color.)

– Set the background to any color by selecting the Custom option and specifying the red, green, and blue
components of the color.

5.4 Grid Toolbox

The Grid toolbox controls the display of the model grid.

• If the Grid toolbox is not visible, display it by clicking the Toolbox menu and selecting Grid.

• The Lines tab allows you to:

– Set the position of gridline set defined by index i, j, or k for gridlines.

– Click the up or down arrow to increase or decrease the i, j, or k indices.

– Show or hide a gridline set by checking or unchecking the Activate option.

– Set the gridline color to black, gray, or white.

• The Shell tab allows you to set the color (red, green, and blue components) and opacity of the shell that represents
the outer surface of the active grid.

• The Subgrid tab allows you to:

– Check the Activate Subgrid option to show a subset of the grid as defined by the range of i, j, and k indices
for cells.

– Uncheck the Activate Subgrid option to show the full grid.

– Specify the minimum and maximum values for the i, j, and k indices.

– Click the up or down arrow to increase or decrease the i, j, or k indices.
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5.5 Geometry Toolbox

The Geometry toolbox controls the geometric aspects of the display.

• If the Geometry toolbox is not visible, display it by clicking the Toolbox menu and selecting Geometry.

• The Scale tab allows you to set the exaggeration or elongation factor in the x, y and z directions. (For no
exaggeration, set all factors to 1.)

• The Axes Symbol tab allows you to:

– Display the axes symbol as tubes or lines.

– Set the size of the axes symbol. (MvMf6 determines a default size of 1. To increase the size, specify a
value greater than 1. To decrease the size, specify a value smaller than 1.)

– Set the tube diameter for the axes symbol. (MvMf6 determines a default tube diameter of 1. To increase
the diameter, specify a value greater than 1. The decrease the diameter, specify a value smaller than 1.)

– Set the (x, y, z) position of the axes symbol.

• The Bounding Box tab allows you to set the color of the bounding box.

5.6 Overlay Toolbox

The Overlay toolbox is used to import an overlay contained in either an ESRI Shapefile or a DXF file.

To import an overlay:

1. If the Overlay toolbox is not visible, display it by clicking the Toolbox menu and selecting Overlay.

2. Click the File tab.

3. Select the Type of file (ESRI Shapefile or DXF file) to be imported.

4. Click the Browse button and navigate to the file you want to import. Double click the file.

5. Click the Control tab.

6. Enter the following information:

• X0 and Y0 are the x and y coordinates in the overlay file (that is, the Shapefile or DXF file) of the point that
coincides with the lower left corner of the grid, when the grid is viewed from directly above.

• Scale is the conversion factor that converts the length unit used in the overlay file to the length unit of the model
grid. For example, if the overlay file data are in meters, and the grid is in feet, then “scale” should be 3.2808.

• Angle is the angle in degrees to rotate the overlay. A positive value cause rotation in the clockwise direction.

7. Next, select either:

• Flat : The overlay is displayed on a flat plane, or

• Drape : The overlay is displayed on the top of the grid.

8. If you select Flat then:

• Enter a value for Elev, which is the elevation (in length unit used by the grid) of the plane on which the overlay
is displayed.

• If you check the Trim option, the overlay will be trimmed so that any portion outside the grid (when viewed
from directly above) is removed. If you activate the subgrid (using the Grid Toolbox), then the overlay will be
trimmed to the subgrid.
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• If you uncheck the Trim option, the entire overlay will be displayed. (Even if you activate the subgrid, the overlay
will not be trimmed.)

9. If you select Drape then:

• The Trim option is automatically turned on and cannot be turned off. This is necessary because the program
doesn’t know how to drape the overlay for those portions outside the grid. Therefore, any portion of the overlay
outside the grid (or subgrid) is removed.

• You may want to raise the overlay slightly above the top of the grid. This can be done by specifying the drape
gap. When the drape gap is zero, the overlay is exactly on the top surface of the grid. If you set the drape gap to
1.5, the overlay is 1.5 length units (whatever length unit used in the model) above the top surface of the grid. (In
solid display, the overlay should be slightly above the top of the grid so that the grid does not partially cover the
overlay.)

10. If desired, select Crop:

• If the you click the Crop option, portions of the overlay are removed so that the overlay appears only above the
cropped solid.

11. Click the Apply button.

5.7 Solid Toolbox

The Solid toolbox controls the display of scalar data as a solid.

• If the Solid toolbox is not visible, display it by clicking the Toolbox menu and selecting Solid.

• To specify the coloring scheme, select one of the options: Blocky, Smooth, or Banded. (The Blocky coloring
scheme is not available for finite-element models such as SUTRA.)

• For the banded coloring scheme, you may set the number of color bands in the text box.

• To apply thresholding:

– Check the Apply Threshold option.

– Specify the minimum and maximum values of the threshold range.

– Click Apply.

• The Full button sets the minimum and maximum values of the threshold range respectively to the minimum and
maximum values of the scalar data at the current time step.

• To turn off thresholding, uncheck the Apply Threshold option.

5.8 Isosurface Toolbox

The Isosurface toolbox is used to create isosurfaces.

• If the Isosurface toolbox is not visible, display it by clicking the Toolbox menu and selecting Isosurface.

• The Regular tab allows you to create isosurfaces at scalar values uniformly spaced between a minimum and a
maximum value. For example, if Min Value = 0, Max Value = 50, No. of Isosurfaces = 6, then isosurfaces will
be created for scalar values of 0, 10, 20, 30, 40, and 50.

• The Custom tab allows you to create isosurfaces for arbitrary scalar values. These values are shown in the list
box on the right.

– To add an isosurface, enter the scalar value in the text box on the left and click Add.
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– To delete an isosurface, select the scalar value in the list box on the right and click Delete.

5.9 Vector Toolbox

The Vector toolbox controls the display of vector data.

• If the Vector toolbox is not visible, display it by clicking the Toolbox menu and selecting Vector.

• Clicking Default will assign default settings to the selected tab. Default settings are given in parentheses below.

• The Subsample tab allows you to display a subset of vectors.

– The subset of vectors is defined by the minimum value (Min), maximum value (Max), and the sampling
rate for the i, j, and k indices. For example, if Min = 3, Max = 20, and Rate = 4 for index i, then vectors will
be displayed at i values of 3, 7, 11, 15 and 19. (By default, Min, Max and Rate are set to show all vectors.)

– You may also click the up or down arrow to increase or decrease the Min or Max values. For SUTRA models
with irregular meshes, only the k rate is active and the nodes throughout the mesh will be subampled based
on their node numbers.

• The Appearance tab allows you to:

– Set the Scale Factor for the vectors. (See note 1 below.) Check of uncheck the Log Transform option
to either apply a log transformation to the ratio of the vector to the smallest vector or to use the vector
magnitudes without transformation.

– Check or uncheck the Show Base option to show or hide small cubes at the starting point of each vector.

– Check the up or down arrow to increase or decrease the size of the base cubes.

– Set the vector color to black, gray, or white. (black)

• The Threshold tab allows you to:

– Check the Apply Threshold option to display only those vectors having magnitudes within the threshold
range.

– Uncheck the Apply Threshold option to turn off thresholding.

– Specify the minimum and maximum vector magnitudes to define the threshold range.

• The Crop tab allows you to:

– Select which vectors are displayed using a cropping procedure similar to that used to crop isosurfaces or
solids.

Note:

1. When model data are loaded, MvMf6 computes a default scale factor based on the maximum vector magnitude
at the selected time to display data. The actual value of the scale factor is unimportant. To lengthen the vectors,
simply increase the scale factor. To shorten the vectors, decrease the scale factor.
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5.10 Model Features Toolbox

The Model Features toolbox controls the display of model features.

• If the Model Features toolbox is not visible, display it by clicking the Toolbox menu and selecting Model
Features.

• The Model Features toolbox contains two lists: the Show list on the left and the Hide list on the right.

• Model features in the Show list are visible; those in the Hide list are invisible.

• To show a model feature in the Hide list, select the item and click Show.

• To hide a model feature in the Show list, select the item and click the Hide.

• If several model features occupy the same cell or node, the uppermost item in the Show list will be displayed.

• The position of a model feature in the Show list may be changed by selecting the item and then clicking

– Top: Move the item to the top of the list

– Up: Move the item up one position

– Down: Move the item down one position

– Bot: Move the item to the bottom of the list

• To change the color of a model feature, select the item, click Color, and then select the color.

• In finite element meshes, to change the size of a model feature click the arrows next to Size.

5.11 Crop Toolbox

The Crop toolbox is used for cropping solid or isosurfaces.

• If the Crop toolbox is not visible, display it by clicking the Toolbox menu and selecting Crop.

• Clicking Default will assign default settings to the selected tab. Default settings are given in parentheses below.

• The Controls tab allows you to:

– Specify the Min and Max positions of the x, y, and z cropping planes. (Min = 0, Max = 1)

– Specify the Delta value, which is used to increase or decrease the Min or Max position when the up or
down arrow is clicked. (0.1)

– Check or uncheck the option Min=Max. When checked, the Min position is set equal to the Max position.
When the up or down arrow is clicked to change Min (or Max) position, the Max (or Min) position is also
changed by the same amount.

– Specify the Crop Angle to rotate the x and y cropping planes. The crop angle can be from -45 to 45 degrees.
(0)

• The Cropped-Away Pieces tab allows you to:

– Check or uncheck the Show to show or hide the cropped-away pieces. (By default, the cropped-away pieces
are not shown.)

– Set the color (red, green, and blue components) and the opacity of the cropped-away pieces. (The default
settings are: red = 1, green = 0.8, blue = 0.6, opacity = 0.2.)
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5.12 Animation Toolbox

The Animation toolbox controls the display of model results at successive times to create an animation.

• If the Animation toolbox is not visible, display it by clicking the Toolbox menu and selecting Animation.

• The Controls tab allows you to do the following:

– To choose whether the animation will advance through time or change the viewpoint without advancing
through time, set the Animation type to “time” or “viewpoint.”

– If the animation type is set to “viewpoint” you can set the Number of steps in the animation.

– To advance to the next time or position, click Advance.

– To run an animation (continuously advance to the next time), click Run.

– To stop a animation, click Stop.

– To set the display to a particular time, select that time from the drop-list box, and then click Set.

• The Options tab allows you to do the following:

– Specify a Delay (in seconds) between successive times. This will slow down the animation. To animate at
the fastest speed, specify a delay of zero.

– Specify an angle increment to Rotate (horizontally) the viewpoint between between successive times.

– Specify an angle increment to Elevate (vertically) the viewpoint between between successive times.

– For a stationary viewpoint during animation, enter 0 in the Rotate and Elevate text boxes.
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CHAPTER

SIX

VIEW CONTROL

The Action menu provides commands to overall aspects of the display.

• Copying the Display to Clipboard

• Resetting the Viewpoint

• Setting Size of Display Area

• Viewing From Preset Directions

• Perspective Versus Parallel Projection

• Saving and Restoring a Viewpoint

6.1 Copying the Display to Clipboard

1. Click the Action menu and select Copy Display to Clipboard.

Note:

• This command copies the current display to the System Clipboard.

• The clipboard content may be pasted to another application that accepts graphical images.

6.2 Resetting the Viewpoint

1. Click the Action menu and select Reset Viewpoint.

Note:

• This command changes the viewpoint so that all visible graphic objects can be seen in the display area.
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6.3 Setting Size of Display Area

1. Click the Action menu and select Set Size of Display Area. . . .

2. Specify the display area width and height in pixels.

3. Click OK.

Note:

• This command is useful for exporting a PNG file of a specific size.

6.4 Viewing From Preset Directions

The viewpoint may be set to view from one of six preset directions.

1. Click the Action menu, select View From Direction, and then select one of six options.

Note:

• For example, if you select the +x option, the viewpoint will be set to view from the +x axis direction towards the
-x axis direction.

• You may switch the viewpoint from one preset direction to the next by clicking View From Next Direction from
the Action menu, or by holding down the Ctrl key and pressing the V key.

6.5 Perspective Versus Parallel Projection

• In perspective projection, parallel lines appear to converge to a point at infinity. This is the default projection
mode.

• In parallel projection, parallel lines appear to remain parallel to each other as they extend to infinity. (Parallel
projction is of limited usefulness in three-dimensional visualization, but can be used to “line up” cells or vectors.)

• To switch projection mode, Click the Action menu, select Set Projection To, and then select either Perspective
or Parallel.
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Note:

• Zooming is not synchronized between perspective and parallel projection modes. The amount of zooming in one
projection mode is independent of the amount of zooming in the other projection mode.

6.6 Saving and Restoring a Viewpoint

1. Click the Action menu and select Save Viewpoint.

2. To restore a previously saved viewpoint, click the Action menu and select Restore Saved Viewpoint.

Note:

• The viewpoint is saved in memory but not on file. The saved viewpoint is discarded when the program exits.
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CHAPTER

SEVEN

EXPORTING

Commands for exporting are located under the File menu.

• Exporting the Display as a PNG

• Exporting an Animation

7.1 Exporting the Display as a PNG

MvMf6 can export a PNG (Portable Network Graphics) of the display area.

1. Resize the display area to the desired dimensions.

2. Click the File menu and select Export As PNG. (See note 1 below.)

3. Select Screen if you want a PNG at the screen resolution. Otherwise, select 150 ppi or 300 ppi and specify
either the width or height (but not both) of the PNG in inches. (See note 2 below.)

4. Click OK.

5. Navigate to the folder in which you want to save the PNG file.

6. In the File Name box, enter the name of the PNG file. This name should end with the extension .png

7. Click Save.

Note:

1. The exported PNG has a color depth of 24 bits per pixel, or a maximum of about 16 million colors.

2. If you select 150 ppi or 300 ppi (pixels per inch) in Step 2, the PNG size will depend on the specified width or
height in inches. If you specify the width, then the height will be automatically determined so that the aspect
ratio of the PNG matches that of the display area. If you specify height, then the width will be automatically
determined. For example, if you specify 300 ppi and a width of 4 inches, the PNG will have 1200 pixels in the x
dimension. When you import such a PNG into an application that recognizes PNG resolution, the PNG will be
displayed as a picture with the specified width and height in inches.
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7.2 Exporting an Animation

MvMf6 can export a sequence of PNG (Portable Network Graphics) files, one for each time when results are saved.
The saved PNG files may be used to create an animation (for example, mpeg, animated gif) using an application that
creates animations. (See Note 1 below)

1. Resize the display area to the desired dimensions. (See Note 2 below)

2. Click the File menu and select Export Animation.

3. Set the Animation type to “time” or “viewpoint.”

4. If the Animation type is set to “viewpoint”, set the Number of steps.

5. If the Animation type is set to “time”, specify the time span in the From and To boxes.

6. In the Rotate box, enter the amount of viewpoint rotation (in degrees) between successive times. (See Note 3
below)

7. In the Elevate box, enter the amount of viewpoint elevation (in degrees) between successive times. (See Note 3
below)

8. Enter the File Prefix and the Start Number. For example, if you enter sim for File Prefix and 001 for Start
Number, then the files will be named sim001.png, sim002.png, sim003.png, etc.

9. Click the Browse button and navigate to the folder in which you want to save the files. Click the folder and then
click Select.

10. To preview the animation that will be saved, click Preview. The program will display the sequence of images to
be saved, but will not save them.

11. To save the animation, click Export. A sequence of PNG files are created.

12. Click Save.

Note:

1. The PNG files are saved at the screen resolution and have the same size as the display area. The color depth is
24 bits per pixel, or a maximum of about 16 million colors.

2. To conserve disk space, resize the display area to a relatively small size before saving the sequence of PNG files.

3. If you want a stationary viewpoint for the animation, enter 0 in both the Rotate and Elevate boxes.
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